IP REMOTE CONTROL SOFTWARE
RS-BA1
Version 2

INTRODUCTION
1 BEFORE USING THE REMOTE CONTROL SYSTEM
2 CONFIGURING THE SYSTEM THROUGH A CABLE
3 CONFIGURING THE SYSTEM THROUGH A LAN
4 CONFIGURING THE SYSTEM THROUGH THE INTERNET
5 ABOUT THE REMOTE UTILITY
6 ABOUT THE REMOTE CONTROLLER
7 TROUBLESHOOTING
Thank you for choosing this Icom product. This product is designed and built with Icom’s state of the art technology and craftsmanship. With proper care, this product should provide you with years of trouble-free operation.

This instruction manual contains detailed instructions on how to configure your own remote control system. Before reading this manual, read the RS-BA1 Preparations that comes with the RS-BA1 for details on how to install the software.

**IMPORTANT**

**READ THIS INSTRUCTION MANUAL CAREFULLY** before using the software.

**SAVE THIS INSTRUCTION MANUAL.** This instruction manual contains important safety and operating instructions for the RS-BA1.

**NOTE:** This instruction manual is based on Icom Remote Utility Version 2.11 and RS-BA1 Version 2.10.

- In this manual, Microsoft® Windows® 10 Home and Microsoft® Windows® 10 Pro are described as “Windows 10.”
- Microsoft® Windows® 8.1 and Microsoft® Windows® 8.1 Pro are described as “Windows 8.1.” The software cannot be used with “RT” versions of Microsoft® Windows® 8.1.
- Microsoft® Windows® 7 Home Premium, Microsoft® Windows® 7 Professional, and Microsoft® Windows® 7 Ultimate are described as “Windows 7.”

**PRECAUTIONS**

**IMPORTANT!** To remotely control radios using the RS-BA1, **BE SURE** that you comply with any local regulations.

The RS-BA1 is designed to remotely control transceivers through a LAN or USB port (Type B/Mini-B). Proper audio communication cannot be guaranteed if you connect the Server PC to the transceiver’s ACC socket, MIC connector, or S/PDIF jack.

Depending on your transceiver, a few functions or modes cannot be used, or you will need to update the transceiver’s firmware to operate a CW keyer, using the RS-BA1 application.

Depending on the PC’s performance, OS, IP provider, connection type, condition, speed, and so on, the USB audio may be interrupted, or control by the PC software may get delayed.

If the CPU has a heavy load, the USB audio is easily interrupted. The settings of your audio player application may be changed after connecting a transceiver to the PC.

To operate your PC and peripheral devices, follow the instructions provided in their manuals.

All copyrights associated with this manual and all intellectual property rights associated with the RS-BA1 application are held by Icom Inc. Unauthorized reproduction or transmission of this manual, or any part hereof, is prohibited.

The content of this manual, the software associated with the RS-BA1, and the appearance of the RS-BA1 are all subject to change without notice.

Icom, Icom Inc. and the Icom logo are registered trademarks of Icom Incorporated (Japan) in Japan, the United States, the United Kingdom, Germany, France, Spain, Russia, Australia, New Zealand, and/or other countries.
Adobe, Acrobat, and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.
Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States, and/or other countries.
All other products or brands are registered trademarks or trademarks of their respective holders.
INTRODUCTION

FUNCTIONS AND FEATURES OF Adobe® Acrobat® Reader®

The following functions and features can be used with Adobe® Acrobat® Reader®.

• **Keyword search**
  Click “Find” (Ctrl+F) or “Advanced Search” (Shift+Ctrl+F) in the Edit menu to open the search screen. This is convenient when searching for a particular word or phrase in this manual.
  ① The menu screen may differ, depending on the Adobe® Acrobat® Reader® version.

• **Find screen**
  Click to open the find or search screen or advanced search screen.

• **Advanced search screen**
  Click to open the find or search screen or advanced search screen.

• **Printing out your desired pages.**
  Click “Print” in the File menu, and then select the paper size and page numbers you want to print.
  ① The printing setup may differ, depending on the printer. Refer to your printer’s instruction manual for details.
  ② Select “A4” size to print out the page in the original manual size.

• **Read Out Loud feature.**
  The Read Out Loud feature reads aloud the text in this PDF.
  Refer to the Adobe® Acrobat® Reader® Help for the details.
  (This feature may not be usable, depending on your PC environment including the operating system.)

① The screen may differ, depending on the Adobe® Acrobat® Reader® version.
COMPATIBLE TRANSCEIVERS

The RS-BA1 is compatible with Icom transceivers that input and output audio through a LAN or the USB port (Type B/Mini-B).

<table>
<thead>
<tr>
<th>Transceiver's connector</th>
<th>Compatible transceivers</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAN port (Transceivers with the Server function)</td>
<td>IC-7851, IC-7850, IC-7800 (Firmware version 3.00 or later), IC-7700 (Firmware version 2.00 or later), IC-7610, IC-9700</td>
</tr>
<tr>
<td>USB port</td>
<td>IC-7100, IC-7200, IC-7300, IC-7410, IC-7600, IC-7610, IC-7850, IC-7851, IC-9100, IC-9700</td>
</tr>
</tbody>
</table>

NOTE:
• If your Icom transceiver does not have a LAN port or a USB port, you can remotely control the transceiver with an RS-232C interface. However, RS-BA1 operation with transceivers that input or output audio through the ACC socket, MIC connector, or S/P DIF jack cannot be guaranteed.
• Depending on your transceiver, some functions or operating modes cannot be used.
• Depending on your transceiver, a firmware update may be required to use the CW mode.

The following transceivers are compatible with the RS-BA1 Dualwatch function:
IC-7851, IC-7850 (Firmware version 1.30 or later)
IC-7610 (Firmware version 1.10 or later)
# TABLE OF CONTENTS

## 1 BEFORE USING THE REMOTE CONTROL SYSTEM
- Firewall settings ................................................................. 1-1
- Adjusting the level of your audio devices .......................... 1-5
- Transceiver’s presettings ..................................................... 1-8
- Selecting a connection method ........................................... 1-10

## 2 CONFIGURING THE SYSTEM THROUGH A CABLE
- Examples of the remote control system ............................ 2-1
- STEP 1. Select a connection method .................................. 2-2
- STEP 2. Connecting the transceiver to the PC .................. 2-3
- STEP 3. Setting the Remote Utility .................................... 2-7
- STEP 4. Starting the Remote control operation ................. 2-11

## 3 CONFIGURING THE SYSTEM THROUGH A LAN
- Examples of the remote control system ............................ 3-1
- STEP 1. Settings on the Base station ................................. 3-2
  - A. When using a transceiver with the Server function ........ 3-2
  - B. When using the Server PC ........................................ 3-4
- STEP 2. Settings on the Remote PC’s Remote Utility application ...................................................... 3-10
- STEP 3. Starting the Remote control operation ................. 3-14

## 4 CONFIGURING THE SYSTEM THROUGH THE INTERNET
- Examples of the remote control system through the Internet ................................................................. 4-1
- About a public IP address and the Dynamic DNS service ................................................................. 4-2
  - To let PCs connect to the Base station using its public IP address ..................................................... 4-2
  - To let PCs connect to the Base station using its domain name ........................................................... 4-3
- Port forwarding ................................................................. 4-4
- STEP 1. Settings on the Base station ................................. 4-5
  - A. When using a transceiver with the Server function ................................................................. 4-5
  - B. When using the Server PC ........................................ 4-7
- STEP 2. Settings on the Remote PC’s Remote Utility application ............................................................... 4-11
- STEP 3. Starting the Remote control operation ................. 4-15
# TABLE OF CONTENTS

## 5 ABOUT THE REMOTE UTILITY
- Setting your PC’s environment ................................................................. 5-1
- Transceiver Registration ................................................................. 5-2
  - Adding a transceiver ................................................................. 5-2
  - Changing a transceiver’s properties ........................................... 5-3
  - Deleting a transceiver ................................................................. 5-3
  - Adding a user who can access the transceiver ......................... 5-4
- Server Registration ........................................................................ 5-7
  - Adding a Server ......................................................................... 5-7
  - Changing a server’s properties .................................................. 5-8
  - Deleting a server .................................................................... 5-8
- Connecting to a Server .................................................................. 5-9
  - Connecting to a Server ............................................................. 5-9
  - Disconnecting from a Server ...................................................... 5-9
- Connection setting ...................................................................... 5-10
- Connecting to a transceiver ........................................................ 5-11
  - Connecting to a transceiver ...................................................... 5-11
  - Disconnecting a transceiver ..................................................... 5-11
- Adjusting audio level using the Remote Utility application .......... 5-12
  - Adjusting received audio volume .............................................. 5-12
  - Adjusting transmit audio volume ............................................. 5-12
- Recording and playback function .................................................. 5-13
  - Recording received audio ....................................................... 5-13
  - Playing back and transmitting an audio file ......................... 5-14
- Monitoring another users from the Server PC .................... 5-15
- Disconnecting another users ......................................................... 5-16

## 6 ABOUT THE REMOTE CONTROLLER
- To use transmit audio input from the PC .................................... 6-2
- About the Remote mode ............................................................... 6-2
- Using the RC-28 ........................................................................ 6-3

## 7 TROUBLESHOOTING ................................................................. 7-1
OVERVIEW OF THE RS-BA1

• The RS-BA1 consists of the Remote Utility, used to configure a remote control system, and the Remote Controller, used to send the CI-V commands to a Base station, to remotely operate it.
• With the RS-BA1, you can configure a remote control system through a LAN or the Internet.

About the Remote Control system
The RS-BA1 Remote Control system basically consists of the following 3 components:
1. Base station: Transceiver, or Transceiver and Server PC*
2. Network (LAN or Internet)
3. Remote station: PC (Remote PC)

* If you use a transceiver that does not have the Server function, you have to connect a PC to the transceiver.

In the Remote Control system, you can transmit or receive the CI-V commands, control commands to turn the transceiver ON or OFF, or communication audio through the Remote Utility.
You can remotely control the base station by the Remote PC using the Remote Controller.

A. When using the transceiver with the Server function

B. When using the transceiver and Server PC
Firewall settings

The Windows operating system includes a firewall setting standard. This is a security function that can prevent improper access to your PC from the Internet. To let the Remote Utility work properly, add it as an exception in the firewall.

**Windows 10**

1. Click the Windows icon, and then click the Setting icon.

2. Click “Network & Internet.”

3. Click “Windows Firewall.”

4. Click “Allow an app through the firewall.”

5. Click <Change settings>.

6. Click <Allow another app...>.

7. Click “Remote Utility Software for Icom Radios” and then click <Add>.

8. In the “Allowed apps and features” list, confirm that “Remote Utility Software for Icom Radios” is displayed and a check mark is in the box, and then click <OK>.
1-2

BEFORE USING THE REMOTE CONTROL SYSTEM

Firewall settings

Windows 8.1

1. Place the mouse pointer in the bottom right corner of the screen.
   • The charms are displayed on the right of the screen.

2. Click the “Settings” charm.

3. Click “Control Panel.”

4. Click “System and Security.”

5. Click “Allow an app through Windows Firewall.”

   • The "Allowed applications" screen is displayed.

6. Click <Change settings>.

7. Click <Allow another app...>.

   • The "Add an app" screen is displayed.

► Continued on the next page.
Before Using the Remote Control System

Firewall settings

Windows 8.1 (Continued)

8. Click “Remote Utility Software for Icom Radios” and then click <Add>.

   ![Add an app](image)

   - Returns to the “Allowed applications” screen.

9. In the “Allowed apps and features” list, confirm that “Remote Utility Software for Icom Radios” is displayed and a check mark is in the box, and then click <OK>.

   ![Allowed applications](image)
1. Click “Control Panel” in the Start menu.
2. Click “System and Security.”

3. Click “Allow a program through Windows Firewall.”

4. Click <Change settings>.

5. Click <Allow another program...>.

6. Click “Icom Remote Utility” and then click <Add>.

7. In the “Allowed programs and features” list, confirm that “Icom Remote Utility” is displayed and a check mark is in the box, and then click <OK>.

• Returns to the “Allowed Programs” screen.

• The “Allowed Programs” screen is displayed.

• The “Add a Program” screen is displayed.
1 BEFORE USING THE REMOTE CONTROL SYSTEM

Adjusting the level of your audio devices

Before you start using the RS-BA1, the PC’s audio volume of your speakers or headsets must be set to a proper level.

Information
• When several audio devices are used, you must individually set each one.
• Configurable items, displayed screens, and terms may differ, depending on your PC.
• These instructions are based on using Windows 10.

Settings for the Remote PC
Adjust the volume level of the audio device that is connected to the PC.
• In the “Playback devices” menu, you can adjust the output level of the speaker or headset.
• In the “Recording devices” menu, you can adjust the modulation level sent to the transceiver.

Settings for the Server PC
Adjust the audio input and output level from or to your transceiver.
• In the “Playback devices” menu, you can adjust the modulation level sent to the transceiver.
• In the “Recording devices” menu, you can adjust the audio input level from the transceiver.

Before adjusting, connect the transceiver and your PC, and turn ON the transceiver. (p. 2-2)

1. Right-click the speaker icon on the taskbar, then click “Playback devices” or “Recording devices.”

2. Select the audio device that you use, then click <Properties>.

- The “Sound” screen is displayed.
- The “Speaker Properties” screen is displayed.

► Continued on the next page.
Adjusting the level of your audio devices

3. Confirm “Use this device (enable)” is displayed in the Device Usage menu on the <General> tab.

4. Click the <Levels> tab. Adjust the speaker's audio level by moving the slide control to the right or left. After adjusting, click <OK> to close “Speaker Properties.”
   ① If the mute setting is turned ON in “Speakers,” click the icon to turn it OFF.

5. Click the <Recording> tab on the “Sound” screen. In the list, select the audio device that you use, and then click <Properties>.

6. Confirm “Use this device (enable)” is displayed in the Device Usage menu on the <General> tab.

7. Click the <Listen> tab. If a check mark is inserted in “Listen to this device,” click to remove it.

8. Click the <Levels> tab. Adjust the microphone’s audio level by moving the slide control to the right or left. If the mute setting is turned ON in “Microphone,” click the icon to turn it OFF.

• The “Microphone Properties” screen is displayed.

► Continued on the next page.
1 BEFORE USING THE REMOTE CONTROL SYSTEM

Adjusting the level of your audio devices

9. When connecting the transceiver to the PC with a USB cable, and when using the RS-BA1 Dualwatch function, click the <Advanced> tab and then confirm the “Default Format” is set to 2 channel.

10. After adjusting, click <OK> to close “Microphone Properties.”
## Transceiver’s presettings

The RS-BA1 remotely controls the transceivers using CI-V (Icom Communication Interface-V) commands. See the CI-V command table in the transceiver’s instruction manual for details of the functions that can be controlled.

### The following manual settings are required when operating the RS-BA1

Properly preset the items in the table below for functions that cannot be controlled by CI-V commands, or for items that may cause unintended actions. See the transceiver’s instruction manual for details of the settings or operation.

### NOTE:
- Remove the transverter from the transceiver, if it is connected.
- To prevent an accidental transmission, we recommend you remove any key, keypad, or other external devices connected to the transceiver.
- Set the transceiver to a normal operating mode. The transceiver cannot receive CI-V commands in special modes, such as the firmware update mode, clone mode, terminal mode, or access point mode.
- If the transceiver has the Time-Out Timer function, we recommend that you turn ON the function to prevent the transceiver from continuously transmitting.

<table>
<thead>
<tr>
<th>Genre</th>
<th>Items</th>
<th>Model</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function</td>
<td>RIT function</td>
<td>Transceivers without the Server function (Except for the IC-7100, IC-7300, IC-7600)</td>
<td>Set to OFF.</td>
</tr>
<tr>
<td></td>
<td>$\Delta$TX function</td>
<td>Transceivers without the Server function (Except for the IC-7300, IC-7600)</td>
<td>Set to OFF.</td>
</tr>
<tr>
<td></td>
<td>Simple band scope</td>
<td>IC-746PRO*, IC-7000*, IC-7100, IC-7400*, IC-7410, IC-9100</td>
<td>Set to OFF.</td>
</tr>
<tr>
<td></td>
<td>SWR Measuring function</td>
<td>IC-746PRO*, IC-7000*, IC-7100, IC-7400*, IC-7410, IC-9100</td>
<td>Set to OFF.</td>
</tr>
<tr>
<td></td>
<td>Weather Alert function</td>
<td>IC-7100</td>
<td>Set to OFF.</td>
</tr>
<tr>
<td></td>
<td>Timer/Sleep Timer function</td>
<td>Transceivers with the Timer function</td>
<td>Set to OFF.</td>
</tr>
<tr>
<td>Display</td>
<td>RTTY decode screen</td>
<td>IC-746PRO*, IC-756PROIII*, IC-7400*</td>
<td>Close the screen.</td>
</tr>
<tr>
<td>Volume</td>
<td>Volume for the RX audio</td>
<td>All</td>
<td>Set to a suitable level.</td>
</tr>
<tr>
<td></td>
<td>CI-V Baud Rate</td>
<td>All</td>
<td>19200 bps (or “Auto”).</td>
</tr>
<tr>
<td></td>
<td>CI-V Address</td>
<td>All</td>
<td>Desired CI-V Address</td>
</tr>
<tr>
<td></td>
<td>CI-V USB Port</td>
<td>IC-7300*, IC-7610**, IC-9700**, IC-7850 (Firmware version 1.10 or later)<em>, IC-7851 (Firmware version 1.10 or later)</em></td>
<td>Set to “Unlink from [REMOTE].”</td>
</tr>
<tr>
<td></td>
<td>CI-V USB Baud Rate</td>
<td>IC-7300*, IC-7610**, IC-9700**, IC-7850 (Firmware version 1.10 or later)<em>, IC-7851 (Firmware version 1.10 or later)</em></td>
<td>Set to “115200” (or “Auto”).</td>
</tr>
<tr>
<td>Set mode</td>
<td>USB Serial Function</td>
<td>Transceivers with a USB (Type B) port</td>
<td>Set to “CI-V” for the selected connection method.</td>
</tr>
<tr>
<td></td>
<td>RS-232C Function</td>
<td>Transceivers with an RS-232C port</td>
<td>Set to “CI-V” for the selected connection method.</td>
</tr>
</tbody>
</table>

*1 Operations cannot be guaranteed.
*2 When connecting to the USB port and using the Scope function.

**NOTE:** When using the IC-PW1, BE SURE to set CI-V Baud Rate to "19200 bps." After changing the transceiver’s CI-V settings, be sure to reset the CPU of the IC-PW1 and set the transceiver’s CI-V settings on the IC-PW1. See the IC-PW1 instruction manual for details.
BEFORE USING THE REMOTE CONTROL SYSTEM

The following settings are automatically set in the transceiver

When the Remote Controller connects to the transceiver, and you select the model name on the Connect Setting screen, the following items are automatically set. If you manually operate the transceiver, set these items.

<table>
<thead>
<tr>
<th>Genre</th>
<th>Items</th>
<th>Model</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function</td>
<td>MAIN/SUB Tranking function</td>
<td>IC-7610, IC-7850 (Firmware version 1.10 or later), IC-7851 (Firmware version 1.10 or later)</td>
<td>Automatically set to OFF.</td>
</tr>
<tr>
<td></td>
<td>SSB/CW Synchronous Tuning</td>
<td>All</td>
<td>Automatically set to OFF.</td>
</tr>
<tr>
<td></td>
<td>Calibration Marker</td>
<td>Transceivers with the Calibration Marker function</td>
<td>Automatically set to OFF.</td>
</tr>
<tr>
<td></td>
<td>VOX function</td>
<td>All</td>
<td>Automatically set to OFF.</td>
</tr>
<tr>
<td></td>
<td>Scan function</td>
<td>All</td>
<td>Automatically cancels the scan.</td>
</tr>
<tr>
<td></td>
<td>RTTY filter</td>
<td>IC-746PRO<em>1, IC-756PROIII</em>1, IC-7400*1</td>
<td>Automatically set to OFF.</td>
</tr>
<tr>
<td></td>
<td>Twin Peak Filter</td>
<td>IC-746PRO<em>1, IC-756PROIII</em>1, IC-7400*1</td>
<td>Automatically set to OFF.</td>
</tr>
<tr>
<td>Display</td>
<td>Dualwatch function*2</td>
<td>IC-7600, IC-7800, IC-756PROIII*1</td>
<td>Automatically set to OFF.</td>
</tr>
<tr>
<td></td>
<td>SUB band</td>
<td>IC-9100, IC-9700</td>
<td>Automatically set to OFF.</td>
</tr>
<tr>
<td></td>
<td>Memory channel/Call channel</td>
<td>All</td>
<td>Automatically set to the VFO mode.</td>
</tr>
<tr>
<td>Operating mode</td>
<td>DR (D-STAR Repeater) mode</td>
<td>IC-7100, IC-9100, IC-9700</td>
<td>Automatically set to OFF.</td>
</tr>
<tr>
<td></td>
<td>Satellite mode</td>
<td>IC-9100, IC-9700</td>
<td>Automatically set to OFF.</td>
</tr>
<tr>
<td>Type of emission</td>
<td>DD (Digital Data) mode</td>
<td>IC-9700</td>
<td>Automatically set to the FM mode.</td>
</tr>
<tr>
<td></td>
<td>CI-V transceive</td>
<td>All</td>
<td>Automatically set to ON.</td>
</tr>
<tr>
<td></td>
<td>CI-V 731 Mode</td>
<td>IC-746PRO<em>1, IC-756PROIII</em>1, IC-7400*1</td>
<td>Automatically set to OFF.</td>
</tr>
</tbody>
</table>

*1 Operations cannot be guaranteed.
*2 The Dualwatch function is automatically set to OFF when using the Single mode screen
1 BEFORE USING THE REMOTE CONTROL SYSTEM

Selecting a connection method

There are 3 connection methods. Select one from the following.

When you want to configure the system using a cable, see Section 2.

When you want to configure the system using a LAN, see Section 3.
① When using a transceiver with the Server function, you do not need a Server PC.

When you want to configure the system using the Internet, see Section 4.
Examples of the remote control system

This section explains the minimum required settings to operate the transceiver through a cable, using the following illustration as an example.
You can also refer to each application’s Help file for assistance with the functions and settings. While the application is open, push the [F1] key on the PC’s keyboard to open the Help file.

**TIP:** If you use an RC-28 REMOTE ENCODER connected to the Remote PC, you can use the RS-BA1 and feel like you are operating the actual transceiver’s MAIN dial.

Transceiver
Name: IC-7300
CI-V address: 94h
Baudrate: 19200

Remote PC
RC-28
(Purchase separately)

Cable
## STEP 1. Select a connection method

Check the connector type on your transceiver and see the following chart to connect your transceiver to the PC. To connect an Icom CI-V command capable transceiver to the PC, you have to make connections for control command and audio communication.

1. The RS-BA1 operation with the PC connected to the transceiver’s ACC socket, MIC connector, or S/P DIF jack for audio communication cannot be guaranteed.

<table>
<thead>
<tr>
<th>Transceiver’s connector</th>
<th>Outline</th>
<th>Model</th>
<th>Ref.</th>
</tr>
</thead>
<tbody>
<tr>
<td>[USB] port</td>
<td>Through a USB cable</td>
<td>IC-7100, IC-7200, IC-7300, IC-7410, IC-7600*1, IC-7610, IC-7850, IC-7851, IC-9100, IC-9700</td>
<td>p. 2-3</td>
</tr>
<tr>
<td>[REMOTE] jack</td>
<td>Through the CT-17 CI-V LEVEL CONVERTER</td>
<td>All</td>
<td>p. 2-4</td>
</tr>
</tbody>
</table>

*1 To turn the transceiver ON or OFF from the Remote Controller, connect to the transceiver’s [REMOTE] jack.

*2 To turn the transceiver ON or OFF from the Remote Controller, connect to the transceiver’s [REMOTE] jack or directly connect to a LAN.
STEP 2. Connecting the transceiver to the PC

When connecting to the transceiver’s [USB] port:

NOTE: For IC-7600 users
To turn the transceiver ON or OFF from the Remote Controller, connect to the transceiver’s [REMOTE] jack. (p. 2-4)

1 System requirements
   • A PC that has a USB 1.1, 2.0, or 3.0 port
   • Icom CI-V command capable transceiver that has a [USB] port (Type B/Mini-B)
   • The USB cable (supplied with the RS-BA1 or a transceiver)

2 Install a USB driver.

   CAUTION: DO NOT connect the transceiver to the PC with the USB cable until the USB driver installation has been completed. The driver is not supported by the Windows® automatic recognition system.

   To use the USB cable between the transceiver and the PC, you must first install a USB driver. The USB driver comes with the RS-BA1. You can also download it from the Icom website.

   NOTE: When a PC with USB 3.0 port is used to operate the transceiver, confirm the driver name. If the name “Silicon Laboratories CP210x USB to UART Bridge (Driver Removal)” is displayed on the Control Panel screen, uninstall it and then install the latest driver.

   The latest driver and installation guide can be downloaded from here: http://www.icom.co.jp/world/index.html
   Read the installation guide before installing the driver.

3 Connect the transceiver to the PC.

   Connect the transceiver to the PC using the USB cable. This guide is based on using a Type B USB cable.

   NOTE:
   • If you connect a new USB audio device to your PC, the device selected as the default on your PC may be changed.
   • DO NOT connect another transceiver using a USB cable while the Remote Utility is open.
STEP 2. Connecting the transceiver to the PC

When connecting to the transceiver’s [REMOTE] jack:

1 **System requirements**
   - A PC that has an RS-232C connector
   - Icom CI-V command capable transceiver that has a [REMOTE] jack
   - The optional CT-17 CI-V LEVEL CONVERTER
     ◆ Mini-plug cables are included
   - An RS-232C cable (Supplied with the CT-17)
   - Stereo audio cables (User supplied)

2 **Connect a remote control system.**
   Connect the CT-17 to the PC, which enables the CI-V communication between them.

   ![Diagram of system setup](image)

   **NOTE:** The CT-17 accepts only an RS-232C cable. The use of an RS-232C-USB converter is not guaranteed.

3 **Connecting an audio cables**
   Connect an audio cable between the PC’s audio ports and the transceiver’s [ACC] socket or [MIC] connector to enable audio communication between them.
   ◆ See the transceiver’s instruction manual for details on the connector.

   ![Diagram of audio connections](image)

   **CAUTION:**
   - When using the [MIC] connector, **DO NOT** directly connect an audio cable between the transceiver’s Microphone input and PC. It can cause a malfunction without adding the Electrolytic capacitor, as illustrated above.
   - **DO NOT** connect a monaural plug to the PC’s LINE OUT. It can cause a malfunction.
STEP 2. Connecting the transceiver to the PC

When connecting to a transceiver’s [RS-232C] connector:

NOTE: For IC-7800 or IC-7700 users
To turn the transceiver ON or OFF from the Remote Controller, connect to the transceiver’s [REMOTE] jack or directly connect to a LAN.

1 System requirements
- A PC that has an RS-232C connector
- Icom CI-V command capable transceiver that has an [RS-232C] connector
- An RS-232C cable (User supplied)
- Two S/P DIF digital cables or stereo audio cables (User supplied)

2 Connect a remote control system.
Connect an RS-232C cable between the transceiver and the PC.
STEP 2. Connecting the transceiver to the PC

When connecting to the transceiver’s [RS-232C] port (Continued):

3 Connecting an audio cables
Connect an audio cable between the PC’s audio port and the transceiver’s [S/PDIF] jack, [ACC] socket, or [MIC] connector to enable audio communication between them.

Using the [S/PDIF] jack

<table>
<thead>
<tr>
<th>Transceiver</th>
<th>PC</th>
</tr>
</thead>
<tbody>
<tr>
<td>S/PDIF OUT</td>
<td>S/PDIF IN (Input)</td>
</tr>
<tr>
<td>(Output)</td>
<td>S/PDIF OUT (Output)</td>
</tr>
<tr>
<td>S/PDIF IN (Input)</td>
<td></td>
</tr>
</tbody>
</table>

Using other than the [S/PDIF] jack

<table>
<thead>
<tr>
<th>Transceiver</th>
<th>PC</th>
</tr>
</thead>
<tbody>
<tr>
<td>AF (Output)</td>
<td>LINE IN/MIC IN (Input)</td>
</tr>
<tr>
<td>MOD (Input)</td>
<td>LINE OUT (Output)</td>
</tr>
</tbody>
</table>

CAUTION:

• When using the [MIC] connector, **DO NOT** directly connect an audio cable between the transceiver’s Microphone input and PC. It can cause a malfunction without adding the Electrolytic capacitor, as illustrated above.
• **DO NOT** connect a monaural plug to the PC’s LINE OUT. It can cause a malfunction.
STEP 3. Setting the Remote Utility

This section describes how to setup the PC.
① Before configuring the settings, turn ON the transceiver.

1. **Open the Remote Utility.**
   1. Open “Icom Remote Utility.”
   2. “Set your own PC information.” is displayed, then click <OK>.
      ① When you first open the Remote Utility, this screen is displayed.

2. **Configure the settings.**
   ① When you first open the Remote Utility, this screen is displayed.
   1. Enter a name for your PC of up to 16 characters. (Example: Server PC)
      ① DO NOT use the same name for more than one PC on your network.
   2. Confirm the port numbers of the Control, Serial and Audio ports.
      ① Normally, use the default port numbers for these ports.
   3. Select your Internet access line type.
   4. Select the software display language.
      ① The selected language will be used as the Help file language.
   5. Click <Register> to save the settings.
   6. Click <OK>, and then restart the Remote Utility.

3. **Click the Setup that you want to do.**
   ① If no servers or no radios are registered, this screen is displayed.
   Click “Setup for a Local PC (Directly connect the radio and PC).”

4. **Start the Setup Wizard.**
   Click <Next>>.
STEP 3. Setting the Remote Utility

5 Select a transceiver.
1. Select a transceiver that you want to add. (Example: USB)
   ① If the transceiver is not listed, click <Search>.
   ② Select “Manual” if the transceiver is connected
to the PC using other than a USB cable.
   Select the connected transceiver from the drop-down list.
2. Click <Next>>.

6 Set the CI-V/COM port settings.
1. Set the CI-V address, Baud rate, and COM Port Number.
   ① If you select “USB” in step 5, there are no
      necessary changes.
2. Click <Next>>.

TIP: When you select “Manual” in step 5
The Audio Settings screen is displayed.
Select the devices that input a received audio from
the transceiver and output a modulation signal to the transceiver, and then click <Next>>.

7 Enter the radio name.
1. Enter the radio name.
   ① The model name and the last 5 digits of the
      serial number are entered by default.
2. Click <Next>>.
STEP 3. Setting the Remote Utility

The registration of the Radio is complete.
Click <Finish>.

By connecting the transceiver to a USB port, the default settings on the REC/PLAY device window may change to the Radio’s Speaker and Microphone. To confirm the settings, click <Sound Settings>.
STEP 3. Setting the Remote Utility

9 Connect the transceiver.
1. Click <Connect>.
   • The dialog that notifies the virtual serial port is displayed.
   ① If the connection fails, and an error screen is displayed, solve the problem. (p. 7-2)
2. Click <OK>.
   • "<<Connected>>" is displayed under the radio name when the connection has succeeded.
STEP 4. Starting the Remote control operation

This section describes how to connect and remotely control a transceiver from a PC using the Remote Controller.

The description in this section is based on the assumption that:

• The transceiver is turned ON.
• The connection to the transceiver using the Remote Utility has succeeded. ("<<Connected>>" is displayed under the radio name.)

1 Connect setting using the Remote Controller application
2. Open “RS-BA1 Remote Control Ver2.”
3. Click < > in the toolbar, or click “Connect Setting...” in the Option menu.
   • The Connect Setting screen is displayed.
   ▪ You cannot change the settings while the transceiver is connected to the Remote Controller.
4. Select a transceiver to access using the Remote Utility application, in Model.
   (Example: IC-7300 (Ver1.20 - ))
5. Select the connection between the transceiver and PC in Connection.
   (Example: USB)
   ▪ If the “MOD Select has also been changed.” dialog may be displayed. Click <OK>.
   ▪ The confirmation dialog for the connection setting may be displayed, depending on the transceiver. If connected correctly, click <OK>.
   (Example: IC-7300 XXXXX)
   ▪ The CI-V settings are automatically loaded from the Remote Utility application to CI-V. The settings include the virtual COM Port number, transceiver’s CI-V address, and baud rate.
   ▪ If the desired transceiver is not displayed in Remote Utility, click <Search> to load the transceiver’s information from the Remote Utility application.
7. Check “Software closing turns OFF the Radio.” to turn OFF the transceiver when the Remote Controller application is closed by clicking < > or “Exit” on the File menu.
   ▪ When the PC shuts down while the Remote Controller application is still running, the transceiver’s power may not turn OFF.
   ▪ For other settings, see the Remote Controller’s Help file.
8. Click <OK> to save the settings and close the screen.

See the Help file.
STEP 4. Starting the Remote control operation

2 Connecting to the transceiver using the Remote Controller application
Click < > in the toolbar, or click “Connect ON” in the File menu.
• When the connection has succeeded, the transceiver’s current data will be displayed on the main panel.

3 Selecting a modulation input connector
To transmit audio when remotely controlling the transceiver from the Remote Controller, configure the following settings, depending on the transceiver’s connector.
1. Click <MIC SET> on the Remote Controller.
   • The MIC SET screen is displayed.
2. Select a connector in MOD Select (Remote ON) (Example: USB), to input transmit audio from the PC to the transceiver.
3. Click the close button to close the screen.

4 Remote control operation
See the RS-BA1 Remote Controller’s Help file for remote operation details, such as how to change the frequency or how to turn ON each function.
① To display the Help file, click “Contents” in the Help menu on the Remote Controller application, or push the [F1] key on your PC’s keyboard.

NOTE:
• DO NOT allow the PC to go into the sleep or standby mode while using the RS-BA1. Otherwise, it might not work properly after the PC resumes normal activity.
• When not using the transceiver:
  Follow the steps below to finish the remote control operation.
  1. Disconnect the transceiver from the Remote Controller application, and then close the Remote Controller application.
  2. Disconnect the transceiver from the Remote Utility application, and then close the Remote Utility application.
  3. Turn OFF the transceiver and the PC.
     ① If you check Software closing turns OFF the Radio., when you close the Remote Controller, the transceiver is also turned OFF.
• When you manually select the transmit audio input connectors to be used after finishing the remote control operation, right-click in the toolbar, or click “Remote Setting...” in the File menu to select.
  ① Regularly, it automatically returns to the original setting before you start the remote control operation.

TIP: Importing the repeater list
You can easily set the DV mode repeater information by importing the repeater list preset for each transceiver. See the RS-BA1 Remote Controller’s Help file for importing details.
Examples of the remote control system

This section explains the minimum required settings to configure a remote control system through a LAN, using the following illustrations as examples.

1. Only the Remote PC users whose ID and password are registered to the Base station transceiver or the Server PC can connect to it. **BE CAREFUL** in managing IDs and passwords.
2. You can also refer to each application's Help file for assistance with the functions and settings. While the application is open, push the [F1] key on the PC's keyboard to open the Help file.

### A. When using a transceiver with the Server function (p. 3-2)

![Diagram of a transceiver connected to a Base station transceiver and a Remote PC.]

**Base station transceiver**
- Name: IC-7851abc
- CI-V address: 8Eh
- Baud rate: 19200
- IP address: 192.168.0.10

**Remote PC**
- Name: User PC
- User ID: USER1
- Password: USER0001

**Transceiver**
- Name: Server PC
- IP address: 192.168.0.10
- Computer name: ServerPC

**TIP:** If you use an RC-28 REMOTE ENCODER connected to the Remote PC, you can use the RS-BA1 and feel like you are using the actual transceiver’s MAIN dial.

### B. When using the Server PC (p. 3-4)

![Diagram of a Server PC connected to a Router and a Remote PC.]

**Server PC**
- Name: Server PC
- IP address: 192.168.0.10
- Computer name: ServerPC

**Remote PC**
- Name: User PC
- User ID: USER1
- Password: USER0001

The user ID, password, and other settings in these illustrations are only examples. Configure the system using your own settings.
STEP 1. Settings on the Base station

◇ A. When using a transceiver with the Server function

Set each setting item on the Base station transceiver.

① If you want to connect to the Internet and remotely control the transceiver, see Section 4.

**NOTE:** When you change a setting that displays “(Valid after Restart),” you must restart the transceiver after setting. After restarting, keep the transceiver’s power ON or remain in the remote standby mode.

### Network setting

<table>
<thead>
<tr>
<th>Items</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>DHCP*</td>
<td>ON (Default)</td>
</tr>
<tr>
<td>Network Name*</td>
<td>A Network Name</td>
</tr>
<tr>
<td></td>
<td>Example: IC-7851</td>
</tr>
<tr>
<td>Network Control</td>
<td>OFF (Default) → ON</td>
</tr>
<tr>
<td>Control Port (UDP)</td>
<td>50001 (Default)</td>
</tr>
<tr>
<td>Serial Port (UDP)</td>
<td>50002 (Default)</td>
</tr>
<tr>
<td>Audio Port (UDP)</td>
<td>50003 (Default)</td>
</tr>
<tr>
<td>Internet Access Line</td>
<td>Your Internet access line type</td>
</tr>
<tr>
<td></td>
<td>Example: FTTH (Fiber To The Home)</td>
</tr>
<tr>
<td></td>
<td>(Default)</td>
</tr>
</tbody>
</table>

* If you set **DHCP** to “OFF” to use the IP address instead of the network name, or you use an IC-7800 or IC-7700, set the items shown below.

### Transceiver registration

<table>
<thead>
<tr>
<th>Items</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Radio Name</td>
<td>A Network Radio Name</td>
</tr>
<tr>
<td></td>
<td>① Up to 16 characters</td>
</tr>
<tr>
<td></td>
<td>Example: IC-7851abc</td>
</tr>
</tbody>
</table>

### Transmit audio setting

(For the IC-7800 and IC-7700)

<table>
<thead>
<tr>
<th>Items</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network MOD Use</td>
<td>ON (Default)</td>
</tr>
</tbody>
</table>

### Items

<table>
<thead>
<tr>
<th>Items</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address</td>
<td>An IP address that is not assigned to any other device. Example: 192.168.0.10 (Default)</td>
</tr>
<tr>
<td>Default Gateway</td>
<td>An IP address of the LAN side on the router Example: 192.168.0.1</td>
</tr>
</tbody>
</table>
CONFIGURING THE SYSTEM THROUGH A LAN

STEP 1. Settings on the Base station

◊ A. When using a transceiver with the Server function (Continued)

User registration

<table>
<thead>
<tr>
<th>Items</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network User1/2/3* ID</td>
<td>A User ID</td>
</tr>
<tr>
<td></td>
<td>① Up to 16 characters</td>
</tr>
<tr>
<td></td>
<td>Example: USER1</td>
</tr>
<tr>
<td>Network User1/2/3* Password</td>
<td>A Password</td>
</tr>
<tr>
<td></td>
<td>① 8 ~ 16 characters</td>
</tr>
<tr>
<td></td>
<td>② At least 2 different characters must be used.</td>
</tr>
<tr>
<td></td>
<td>Example: USER0001</td>
</tr>
<tr>
<td>Network User1/2/3* Administrator</td>
<td>NO (Default) → YES</td>
</tr>
<tr>
<td></td>
<td>① When the user is set as an administrator.</td>
</tr>
</tbody>
</table>

* There is no User3 in the IC-7610 or IC-9700.

NOTE: To prevent unauthorized access
Set a long and strong password so that no one can possibly guess it. Mix upper and lower case letters, numbers or characters. Periodically changing the password is recommended.

TIP: Standby mode setting
To remotely control the transceiver using the RS-BA1, the transceiver should be turned ON or be in the standby mode.

To set the transceiver in the standby mode, set the item described below and select “Standby (for Remote Control)” on the displayed screen when you turn OFF the transceiver.

① The LED above [POWER] slowly blinks orange if the transceiver is in the standby mode.

<table>
<thead>
<tr>
<th>Items</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shutdown Function</td>
<td>Standby/Shutdown</td>
</tr>
<tr>
<td>(Except for the IC-7610)</td>
<td></td>
</tr>
<tr>
<td>Power OFF Setting (for Remote Control)</td>
<td>Standby/Shutdown</td>
</tr>
<tr>
<td>(For the IC-7610)</td>
<td></td>
</tr>
</tbody>
</table>

NOTE: Before “STEP 2. Settings on the Remote PC’s Remote Utility application” (p. 3-10)
Confirm the transceiver settings described below.

① Keep the transceiver’s power ON, or remain in the Remote Standby mode.
B. When using the Server PC

Connect the transceiver to the Server PC and setup the Remote Utility.
① If you want to connect to the Internet and remotely control the transceiver, see Section 4.

1. **Connect the transceiver to the Server PC.**
   - Connect the transceiver to the Server PC with a cable.
   - See page 2-2 about the connection.

2. **Open the Remote Utility.**
   1. Open “Icom Remote Utility.”
   2. “Set your own PC information.” is displayed, then click <OK>.
      - When you first open the Remote Utility, this screen is displayed.

3. **Configure the settings.**
   ① When you first open the Remote Utility, this screen is displayed.
   1. Enter a name for your PC of up to 16 characters. (Example: Server PC)
      - DO NOT use the same name for more than one PC on your network.
   2. Confirm the port numbers of the Control, Serial and Audio ports.
      - You should use the default port numbers for these ports.
   3. Select your internet access line type.
   4. Select the software display language.
      - The selected language will be used as the Help file language.
   5. Click <Register> to save the settings.
   6. Click <OK>, and then restart the Remote Utility.

4. **Click the Setup that you want to do.**
   ① If no Servers and no transceivers are registered, this screen is displayed.
   Click “Setup for a Server PC (The radio is accessible by Remote PC(s)).”

5. **Start the Setup Wizard.**
   Click <Next>>.
3 CONFIGURING THE SYSTEM THROUGH A LAN

STEP 1. Settings on the Base station

◊ B. When using the Server PC (Continued)

6 Select a Radio for the Remote operation.
1. Select a transceiver that you want to add.
   ① If the transceiver has already been registered, select “Registered radios” and select it from the drop-down list.
2. Click <Next>>.

7 Selecting a Radio
① If you select “Registered radios” in step 6, go to the next page (step 9).
1. Select a connection type (Example: USB).
   ① If the transceivers are not listed, click <Search>.
   ② Select “Manual” if the transceiver is connected to the PC using other than a USB cable.
   Select the connected transceiver from the drop-down list.
2. Click <Next>>.

8 Set the CI-V/COM port settings.
① If you select “Registered radios” in step 6, go to the next page (step 9).
1. Set the CI-V address, Baud Rate, and COM Port Number.
   ① If you select “USB” in step 5, there are no necessary changes.
2. Click <Next>>.
When you select “Manual” in step 7:
The Audio Settings screen is displayed. Select the devices that input a received audio from the transceiver and output a modulation to the transceiver, and then click <Next>>.

**Register a User to allow a connection.**
1. Click <Add>.
   - The Add User screen is displayed.
2. Enter a User ID. (Example: USER1)
3. Enter a password of more than 8 characters. (Example: USER0001)
4. Click <OK>.
5. Select a registered user.
6. Click <Add >>>.
7. Click <Next >>.

**NOTE:** To prevent unauthorized access
Set a long and strong password so that no one can possibly guess it. Mix upper and lower case letters, numbers or characters. Periodically changing the password is recommended.
STEP 1. Settings on the Base station

B. When using the Server PC (Continued)

10 Enter the radio name.
1. Enter the radio name.
   "The radio's model name and the last 5 digits of
   the serial number is entered by default.
2. Click <Next>>.

11 The registration of the Radio is completed.
   Click <Finish>.

By connecting the transceiver to a USB port,
the default settings on the REC/PLAY device
window may change to the Radio's Speaker
and Microphone. To confirm the settings, click
<Sound Settings>.

NOTE: Before “Step 2. Settings on the Remote PC’s Remote Utility application”
Confirm the Server PC settings described below.
• PC name or IP Address
• User ID and Password registered to the Remote Utility
   "Keep the transceiver’s power ON and open the Remote Utility."
STEP 1. Settings on the Base station

B. When using the Server PC (Continued)

TIP: Server PC name and IP address
If you configure the remote control system through a LAN, Remote stations can access the server using the Server PC’s computer name or IP address.

A computer name is used on networks to identify a particular workstation on the network. The example below describes how to find out the Server PC’s computer name or IP address to be requested by Remote stations. Find out your PC’s computer name.

1. Click the folder icon on the taskbar.
2. Right-click “This PC,” and then click “Properties.”
3. The “System” screen is displayed. Confirm the name that is displayed in **Computer name**.
STEP 1. Settings on the Base station

B. When using the Server PC (Continued)

TIP: Server PC name and IP address (continued)
An IP address is a numerical label that is assigned to devices participating in a computer network. Find out your PC’s IP address.

1. Right-click the Network icon on the taskbar, and then click “Open Network & Internet settings.”

2. Click “Network and Sharing Center.”

3. The Network and Sharing Center screen is displayed, and then click “Ethernet.”

4. The Ethernet Status screen is displayed, and then click <Details...>.

5. The Network Connection Details screen is displayed, and then confirm the IP address that is displayed in the Address field. Click <Close> to close the window.

TIP: When DHCP Enabled is set to “Yes” in the Network Connection Details screen, the DHCP server assigns a dynamic IP address to your PC. Therefore, Remote stations have to match the IP address each time to access the Server PC. If DHCP Enabled is set to “Yes,” we recommend that you let Remote stations access the Server PC using its computer name.
**STEP 2. Settings on the Remote PC’s Remote Utility application**

This section describes how to setup the Remote PC.

1. Before configuring the settings, connect a speaker and microphone or headset to the PC.

1. **Open the Remote Utility.**
   1. Open "Icom Remote Utility."
   2. "Set your own PC information." is displayed, then click <OK>.
      - When you first open the Remote Utility, this screen is displayed.

2. **Configure the settings.**
   1. When you first open the Remote Utility, this screen is displayed.
   1. Enter a name for your PC of up to 16 characters. (Example: User PC)
      - DO NOT use the same name for more than one PC on your network.
   2. Confirm the port numbers of the Control, Serial and Audio ports.
      - You should use the default port numbers for these ports.
   3. Select your Internet access line type.
   4. Select the software display language.
      - The selected language will be used as the Help file language.
   5. Click <Register> to save the settings.
   6. Click <OK>, and then restart the Remote Utility.

3. **Click the Setup that you want to do.**
   1. If no servers nor no radios are registered, this screen is displayed.
   2. Click "Setup for a Remote PC (A radio with the Server function)" or "Setup for a Remote PC (Connect through a Server PC)."
      - Example: “Setup for a Remote PC (A radio with the Server function)"

4. **Start the Setup Wizard.**
   Click <Next>>.
STEP 2. Settings on the Remote PC’s Remote Utility application

5 Enter the Server Information.
1. Enter the transceiver Network Name or IP Address.
   ① When using a Server PC, enter the Server PC’s computer name or IP address. (p. 3-8)
2. Confirm the Control Port number.
   ① You should use the default port number for this port.
3. Click <Next>>.

6 Enter the User ID and Password.
1. Enter the User ID and Password that are registered to the transceiver.
2. Click <Next>>.
   • After clicking <Next>>, connects to the server.

7 Adding the Server has been completed.
1. Enter the Server Description.
   ① The Server Address or Network Name is entered by default.
2. Click <Finish>.

TIP: If you cannot connect to the server, an error dialog is displayed. Click <<Back>>, and confirm the settings.
Configure the settings to connect to the transceiver.

1. Select the transceiver.
2. Click <Settings>.
3. Click <Recommended>.
   • The Select Network screen is displayed.
4. Select LAN.
5. Click <Next>.
   • The recommended values for your network are displayed.
6. Click <Yes> to automatically set the displayed values in each field of the Network Setting, then close the Select Network screen.
7. Select a virtual COM port number.
   ① The selected COM port number is used for CI-V operation with the transceiver.
   ② When you connect to the transceiver with the Remote Controller, you have to set the COM port number.
8. Select an audio device in Speaker that your speaker is connected, to output the received audio from the network.
9. Select an audio device in Mic that your microphone is connected, to transmit the input audio to the network.
10. Click <OK>.
Connect the transceiver.

1. Click <Connect>.
   • The dialog that indicates the virtual serial port is displayed.
     ① If the connection fails, and an error screen is displayed, solve the problem. (p. 7-2)
2. Click <OK>.
   • "<<Connected>>" is displayed under the radio name when the connection has succeeded.
STEP 3. Starting the Remote control operation

This section describes how to connect and start remotely controlling a transceiver from a Remote PC using the Remote Controller.

The description in this section is based on the assumption that the connection to the transceiver using the Remote Utility has succeeded. ("<<Connected>>" is displayed under the radio name.)

1. Connect setting using the Remote Controller application
   1. Open “RS-BA1 Remote Control Version 2.”
   2. Click < > in the toolbar, or click “Connect Setting...” in the Option menu.
      • The Connect Setting screen is displayed.
      ① You cannot change the settings while the transceiver is connected to the Remote Controller.
   3. Select a transceiver to access using the Remote Utility application, in Model.
      (Example: IC-7851 (Ver1.30 - ) (DUAL))
   4. Select the connection between the transceiver and PC in Connection. (Example: LAN)
      ① When the “MOD Select has also been changed.” dialog is displayed, click <OK>.
      ① The confirmation dialog for the connection setting may be displayed, depending on the transceiver. If connected correctly, click <OK>.
   5. Select a transceiver to access using the Remote Utility application, in Remote Utility.
      (Example: IC-7851abc)
      • The CI-V settings are automatically loaded from the Remote Utility application to CI-V. The settings include the virtual COM Port number, transceiver’s CI-V address, and baud rate.
      ① If the desired transceiver is not displayed in Remote Utility, click <Search> to load the transceiver’s information from the Remote Utility application.
   6. Check “Software closing turns OFF the Radio.” to turn OFF the transceiver when the Remote Controller application is closed by clicking < > or “Exit” on the File menu.
      ① When you shut down the PC while the Remote Controller application is still running, the transceiver may not be turned OFF.
      ① For other settings, see the Remote Controller’s Help file.
   7. Click <OK> to save the settings and close the screen.
STEP 3. Starting the Remote control operation

2 Connecting to the transceiver using the Remote Controller application
   Click < in the toolbar, or click “Connect ON” in the File menu.
   • When the connection has succeeded, the transceiver’s current data will be displayed on the main panel.

3 Selecting a modulation input connector
   To transmit audio when remotely controlling the transceiver from the Remote Controller, configure the following settings, depending on the transceiver’s connector.
   1. Click <MIC SET> on the Remote Controller.
      • The MIC SET screen is displayed.
   2. Select an appropriate connector in MOD Select (Remote ON) (Example: LAN), to input transmit audio from the PC to the transceiver.
   3. Click the close button to close the screen.

4 Remote control operation
   See the RS-BA1 Remote Controller’s Help file for remote operation details, such as how to change the frequency or how to turn ON each function.
   To display the Help file, click “Contents” in the Help menu on the Remote Controller application, or push the [F1] key on your PC’s keyboard.

NOTE:
• DO NOT allow the PC to go into the sleep or standby mode while using the RS-BA1. Otherwise, it might not work properly after the PC resumes normal activity.

• When not using the transceiver:
  Follow the steps below to finish the remote control operation.
  1. Disconnect the transceiver from the Remote Controller application, and then close the Remote Controller application.
  2. Disconnect the transceiver from the Remote Utility application, and then close the Remote Utility application.
  3. Turn OFF the transceiver and the PC.
     • If you check Software closing turns OFF the Radio., when you close the Remote Controller, the transceiver is also turned OFF.
• When you manually select the transmit audio input connectors to be used after finishing the remote control operation, right-click < in the toolbar, or click “Remote Setting...” in the File menu to select.
• Regularly, it automatically returns to the original setting before you start the remote control operation.

TIP: Importing the repeater list
You can easily set the DV mode repeater information by importing the repeater list preset for each transceiver. See the RS-BA1 Remote Controller’s Help file for importing details.
Examples of the remote control system through the Internet

This section explains the minimum required settings to configure a remote control system through the Internet, using the following illustrations as examples.

1. Only the Remote PC users whose ID and password are registered to the Base station transceiver or the Server PC can connect to it. **BE CAREFUL** in managing IDs and passwords.

2. You can also refer to each application’s help file for assistance with the functions and settings. While the application is open, push the [F1] key on the PC’s keyboard to open the help file.

A. When using the transceiver with the Server function (p. 4-5)

B. When using the Server PC (p. 4-7)

1. The user ID, password, and other settings in these illustrations are only examples. Configure the system using your own settings.

**TIP:** If you use an RC-28 REMOTE ENCODER connected to the Remote PC, you can use the RS-B/A1 and feel like you are using the actual transceiver’s MAIN dial.
About a public IP address and the Dynamic DNS service

If you configure the remote control system through the Internet, PCs can connect to the transceiver using its public IP address or domain name.

◊ To let PCs connect to the Base station using its public IP address

A public IP address is an address that is accessible over the global Internet. Check the router’s manual about how to configure your router to set the public IP address.

**NOTE:**
- If you have a dynamic public IP address, we recommend that you use the Dynamic DNS service to enable the PCs to connect to the transceiver.
- If the PC connected to the transceiver is not using the Dynamic DNS service, you need to change setting of PC’s Remote Utility to connect to the transceiver each time its public IP address changes.
About a public IP address and the Dynamic DNS service

To let PCs connect to the Base station using its domain name

If you set up an account for a Dynamic DNS server, the DNS server resolves the domain name into your dynamic IP address. Using the domain name, PCs can connect to the Base station through the Internet, even if the Base station’s public IP address is changed.

1. Check the router’s manual about how to configure your router to use the Dynamic DNS services.

IP address
WAN: ***.***.***.***
LAN: 192.168.0.1
Domain name: icom-rsba1.com

Request “icom-rsba1.com” (Domain name)
Port forwarding

If you configure the remote control system through the Internet, you need to configure your router to enable connections from the Internet.
To enable connections, forward the port used with the Remote Utility.

**NOTE:** Icom is not responsible for any accidents caused by the security degradation after this port forwarding.

1. Set the static local IP address to the Base station or Server PC.
   Set a static local IP address to the Base station or Server PC.
   
   **Information**
   - Useable IP addresses differ, depending on your router. Check the router’s manual for details.
   - **DO NOT** set the same IP address to 2 or more devices that are connected to the same router.
   - Check your PC’s manual about the setting details.

   **Transceiver setting**

<table>
<thead>
<tr>
<th>Items</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>DHCP</td>
<td>ON (Default) → OFF</td>
</tr>
<tr>
<td>IP Address</td>
<td>An IP address that is not assigned to any other device. Example: 192.168.0.10 (Default)</td>
</tr>
<tr>
<td>Default Gateway</td>
<td>An IP address of the LAN side on the router Example: 192.168.0.1</td>
</tr>
<tr>
<td>Control Port (UDP)</td>
<td>50001 (Default)</td>
</tr>
<tr>
<td>Serial Port (UDP)</td>
<td>50002 (Default)</td>
</tr>
<tr>
<td>Audio Port (UDP)</td>
<td>50003 (Default)</td>
</tr>
</tbody>
</table>

2. Forward the port.
   - Forward port numbers that are used for the RS-BA1. (Default: 50001 ~ 50003)
   - “UDP” should be used as the port protocol.
   - Set a static local IP address in step 1 as a destination port.

   ① Check the router’s manual about how to forward ports.
   ② Depending on the router settings, you must configure the IP filter settings. Check the router’s manual how to configure the settings.
STEP 1. Settings on the Base station

◊ A. When using a transceiver with the Server function
Set each setting item on the Base station transceiver.

**NOTE:** When you change a setting that displays “(Valid after Restart),” you must restart the transceiver after setting. After restarting, keep the transceiver’s power ON or remain in the remote standby mode.

<table>
<thead>
<tr>
<th>Network setting</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Control</td>
<td>OFF (Default) → ON</td>
</tr>
<tr>
<td>Internet Access Line</td>
<td>Your Internet access line type</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>User registration</th>
<th>Contents</th>
</tr>
</thead>
</table>
| Network User1/2/3* ID | A User ID  
|                   | ① Up to 16 characters | Example: USER1 |
| Network User1/2/3* Password | A Password  
|                   | ① 8 ~ 16 characters  
|                   | ② At least 2 different characters must be used. | Example: USER0001 |
| Network User1/2/3* Administrator | NO (Default) → YES  
|                   | ① When the user is set as an administrator. |

* There is no User3 in the IC-7610 or IC-9700.

**NOTE:** To prevent unauthorized access
Set a long and strong password so that no one can possibly guess it. Mix upper and lower case letters, numbers or characters. Periodically changing the password is recommended.
STEP 1. Settings on the Base station

◊ A. When using a transceiver with the Server function (Continued)

**Transceiver registration**

<table>
<thead>
<tr>
<th>Items</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Radio Name</td>
<td>A Network Radio Name</td>
</tr>
<tr>
<td></td>
<td>† Up to 16 characters</td>
</tr>
<tr>
<td></td>
<td>Example: IC-7851abc</td>
</tr>
</tbody>
</table>

**Transmit audio setting**

(For the IC-7800 and IC-7700)

<table>
<thead>
<tr>
<th>Items</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network MOD Use</td>
<td>ON (Default)</td>
</tr>
</tbody>
</table>

**TIP: Standby mode setting**

To remotely control the transceiver using the RS-BA1, the transceiver should be turned ON or be in the standby mode.

To set the transceiver in the standby mode, set the item described below and select “Standby (for Remote Control)” on the displayed screen when you turn OFF the transceiver.

† The LED above [POWER] slowly blinks orange if the transceiver is in the standby mode.

<table>
<thead>
<tr>
<th>Items</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power OFF Setting (for Remote Control)</td>
<td>Standby/Shutdown</td>
</tr>
</tbody>
</table>

**NOTE: Before “STEP 2. Settings on the Remote PC’s Remote Utility application” (p. 4-11)**

Confirm the settings described below.

• Public IP adress or Domain name (p. 4-2)
• Base station’s Network User ID and Password
• Keep the transceiver’s power ON, or remain in the Remote Standby mode
STEP 1. Settings on the Base station

B. When using the Server PC
Connect the transceiver to the Server PC and setup the Remote Utility.

1. Connect the transceiver to the Server PC.
   - Connect the transceiver to the Server PC with a cable.
   - See page 2-2 about the connection.

2. Open the Remote Utility.
   1. Open “Icom Remote Utility.”
   2. “Set your own PC information.” is displayed, then click <OK>.
      - When you first open the Remote Utility, this screen is displayed.

3. Configure the settings.
   1. When you first open the Remote Utility, this screen is displayed.
      1. Enter a name for your PC of up to 16 characters. (Example: Server PC)
         - DO NOT use the same name for more than one PC on your network.
      2. Confirm the port numbers of the Control, Serial and Audio ports.
         - You should use the default port numbers for these ports.
      3. Select your internet access line type.
      4. Select the software display language.
         - The selected language will be used as the Help file language.
      5. Click <Register> to save the settings.
      6. Click <OK>, and then restart the Remote Utility.

4. Click the Setup that you want to do.
   1. If no Servers and no radios are registered, this screen is displayed.
      Click “Setup for a Server PC (The radio is accessible by Remote PC(s)).”

5. Start the Setup Wizard.
   Click <Next>>.
STEP 1. Settings on the Base station

B. When using the Server PC (Continued)

6 Select a Radio for the Remote operation.

1. Select a transceiver that you want to add.
   ① If the transceiver has already been registered, select “Registered radios” and select it from the drop-down list.
   2. Click <Next>>.

7 Selecting a Radio

① If you select “Registered radios” in step 6, go to the next page (step 9).

1. Select a connection type (Example: USB).
   ① If the transceivers are not listed, click <Search>.
   ① Select “Manual” if the transceiver is connected to the PC using other than a USB cable.
   Select the connected transceiver from the drop-down list.
   2. Click <Next>>.

8 Set the CI-V/COM port settings.

① If you select “Registered radios” in step 6, go to the next page (step 9).

1. Set the CI-V address, Baud Rate, and COM Port Number.
   ① If you select “USB” in step 5, there are no necessary changes.
   2. Click <Next>>.
When you select “Manual” in step 7:
The Audio Settings screen is displayed.
Select the devices that input a received audio from
the transceiver and output a modulation to the
transceiver, and then click <Next>>.

Register a User to allow a connection.
1. Click <Add>.
   • The Add User screen is displayed.
2. Enter a User ID. (Example: USER1)
3. Enter a password of more than 8 characters. (Example: USER0001)
4. Click <OK>.
5. Select a registered user.
6. Click <Add >>>.
7. Click <Next >>.

NOTE: To prevent unauthorized access
Set a long and strong password so that no one can possibly guess it. Mix upper and lower case letters, numbers
or characters. Periodically changing the password is recommended.
STEP 1. Settings on the Base station

10 Enter the radio name.
1. Enter the radio name.
   ⦿ The radio’s model name and the last 5 digits of the serial number is entered by default.
2. Click <Next>>.

11 The registration of the Radio is completed.
Click <Finish>.

By connecting the transceiver to a USB port, the default settings on the REC/PLAY device window may change to the Radio’s Speaker and Microphone. To confirm the settings, click <Sound Settings>.

NOTE: Before “STEP 2. Settings on the Remote PC’s Remote Utility application” (p. 4-11)
Confirm the settings described below.
• Public IP adress or Domain name
• Base station’s Network User ID and Password
① Keep the transceiver’s power ON, or remain in the Remote Standby mode
This section describes how to setup the Remote PC.

1. Before configuring the settings, connect a speaker and microphone or headset to the PC.

2. **Configure the settings.**
   1. Enter a name for your PC of up to 16 characters. (Example: User PC)
   2. Confirm the port numbers of the Control, Serial and Audio ports.
   3. Select your Internet access line type.
   4. Select the software display language.
      - The selected language will be used as the Help file language.
   5. Click <Register> to save the settings.
   6. Click <OK>, and then restart the Remote Utility.

3. **Click the Setup that you want to do.**
   1. If no servers nor no radios are registered, this screen is displayed.
   2. Click “Setup for a Remote PC (A radio with the Server function)” or “Setup for a Remote PC (Connect through a Server PC).”
   3. Example: “Setup for a Remote PC (A radio with the Server function)”

4. **Start the Setup Wizard.**
   1. Click <Next>>.

---

**STEP 2. Settings on the Remote PC’s Remote Utility application**

1. **Open the Remote Utility.**
   1. Open “Icom Remote Utility.”
   2. “Set your own PC information.” is displayed, then click <OK>.
      - When you first open the Remote Utility, this screen is displayed.

2. **Configure the settings.**
   1. When you first open the Remote Utility, this screen is displayed.
   2. Enter a name for your PC of up to 16 characters. (Example: User PC)
      - DO NOT use the same name for more than one PC on your network.
   3. Confirm the port numbers of the Control, Serial and Audio ports.
      - You should use the default port numbers for these ports.
   4. Select your Internet access line type.
   5. Select the software display language.
      - The selected language will be used as the Help file language.
   6. Click <Register> to save the settings.
   7. Click <OK>, and then restart the Remote Utility.

3. **Click the Setup that you want to do.**
   1. If no servers nor no radios are registered, this screen is displayed.
   2. Click “Setup for a Remote PC (A radio with the Server function)” or “Setup for a Remote PC (Connect through a Server PC).”
   3. Example: “Setup for a Remote PC (A radio with the Server function)”

4. **Start the Setup Wizard.**
   1. Click <Next>>.
STEP 2. Settings on the Remote PC’s Remote Utility application

5  Enter the Server Information.
   1. Enter the Base station’s domain name or public IP Address.
   2. Confirm the Control Port number.
      ① You should use the default port number for this port.
   3. Click <Next>>.

6  Enter the User ID and Password.
   1. Enter the User ID and Password that are registered to the transceiver.
   2. Click <Next>>.
      • After clicking <Next>>, connects to the server.

TIP: If you cannot connect to the server, an error dialog is displayed.
Click <<Back>>, and confirm the settings.

7  Adding the Server has been completed.
   1. Enter the Server Description.
      ① The Server Address or Network Name is entered by default.
   2. Click <Finish>.
8 Configure the settings to connect to the Base station.

1. Select the transceiver.
2. Click <Settings>.
3. Click <Recommended>.
   • The Select Network screen is displayed.
4. Select Internet.
5. Click <Next>.
   • The recommended values for your network are displayed.
6. Click <Yes> to automatically set the displayed values in each field of the Network Setting, then close the Select Network screen.
7. Select a virtual COM port number.
   ① The selected COM port number is used for CI-V operation with the transceiver.
   ② When you connect to the transceiver with the Remote controller, you have to set the COM port number.
8. Select an audio device in Speaker that your speaker is connected, to output the received audio from the network.
9. Select an audio device in Mic that your microphone is connected, to transmit the input audio to the network.
10. Click <OK>.
Connect the transceiver.

1. Click <Connect>.
   - The dialog that indicates the virtual serial port is displayed.
   - If the connection fails, and an error screen is displayed, solve the problem. (p. 7-2)
2. Click <OK>.
   - "<<Connected>>" is displayed under the radio name when the connection has succeeded.
STEP 3. Starting the Remote control operation

This section describes how to connect and start remotely controlling a transceiver from a Remote PC using the Remote Controller.

The description in this section is based on the assumption that the connection to the transceiver using the Remote Utility has succeeded. ("<<Connected>>" is displayed under the radio name.)

1 Connect setting using the Remote Controller application
   1. Open “RS-BA1 Remote Control Version 2.”
   2. Click < > in the toolbar, or click “Connect Setting...” in the Option menu.
      - The Connect Setting screen is displayed.
      ① You cannot change the settings while the transceiver is connected to the Remote Controller.
   3. Select a transceiver to access using the Remote Utility application, in Model.
      (Example: IC-7851 (Ver1.30 - ) (DUAL))
   4. Select the connection between the transceiver and PC in Connection. (Example: LAN)
      ① When the “MOD Select has also been changed.” dialog is displayed, click <OK>.
      ② The confirmation dialog for the connection setting may be displayed, depending on the transceiver. If connected correctly, click <OK>.
   5. Select a transceiver to access using the Remote Utility application, in Remote Utility.
      (Example: IC-7851abc)
      - The CI-V settings are automatically loaded from the Remote Utility application to CI-V. The settings include the virtual COM Port number, transceiver’s CI-V address, and baud rate.
      ① If the desired transceiver is not displayed in Remote Utility, click <Search> to load the transceiver’s information from the Remote Utility application.
   6. Check “Software closing turns OFF the Radio.” to turn OFF the transceiver when the Remote Controller application is closed by clicking < > or “Exit” on the File menu.
      ① When you shut down the PC while the Remote Controller application is still running, the transceiver may not be turned OFF.
      ② For other settings, see the Remote Controller’s Help file.
   7. Click <OK> to save the settings and close the screen.
STEP 3. Starting the Remote control operation

2 Connecting to the transceiver using the Remote Controller application
Click < > in the toolbar, or click “Connect ON” in the File menu.
• When the connection has succeeded, the transceiver’s current data will be displayed on the main panel.

3 Selecting a modulation input connector
To transmit audio when remotely controlling the transceiver from the Remote Controller, configure the following settings, depending on the transceiver’s connector.
1. Click <MIC SET> on the Remote Controller.
   • The MIC SET screen is displayed.
2. Select an appropriate connector in **MOD Select (Remote ON)** (Example: LAN), to input transmit audio from the PC to the transceiver.
3. Click the close button to close the screen.

4 Remote control operation
See the RS-BA1 Remote Controller’s Help file for remote operation details, such as how to change the frequency or how to turn ON each function.
To display the Help file, click “Contents” in the Help menu on the Remote Controller application, or push the [F1] key on your PC’s keyboard.

**NOTE:**
• **DO NOT** allow the PC to go into the sleep or standby mode while using the RS-BA1. Otherwise, it might not work properly after the PC resumes normal activity.
• **When not using the transceiver:**
  Follow the steps below to finish the remote control operation.
  1. Disconnect the transceiver from the Remote Controller application, and then close the Remote Controller application.
  2. Disconnect the transceiver from the Remote Utility application, and then close the Remote Utility application.
  3. Turn OFF the transceiver and the PC.
  † If you check **Software closing turns OFF the Radio**, when you close the Remote Controller, the transceiver is also turned OFF.
• When you manually select the transmit audio input connectors to be used after finishing the remote control operation, right-click < > in the toolbar, or click “Remote Setting...” in the File menu to select.
  † Regularly, it automatically returns to the original setting before you start the remote control operation.

**TIP: Importing the repeater list**
You can easily set the DV mode repeater information by importing the repeater list preset for each transceiver.
See the RS-BA1 Remote Controller’s Help file for importing details.
Setting your PC’s environment

Configure your PC’s environment in the Remote Utility.
The settings will take effect after rebooting the Remote Utility.
① When you first open the Remote Utility, the Settings screen is displayed.
After configuring the settings, you can display other setting screens.

1. Click “Options.”
2. Click “Settings.”
   • The “Settings” screen is displayed.
3. Configure the settings.
4. Click <OK> to save the settings.
   • “The changes will be effect after the application
       restarts.” is displayed.
5. Click <OK>.
   ① The settings will take effect after restarting the
       Remote Utility.

PC Name
Enter a name for your PC of up to 16 characters.
① DO NOT use the same name for more than one PC on your network.

Port numbers
Enter the port numbers of the Control, Serial, and Audio ports.
You should use the default port numbers for these ports.

Internet Access Line
Select your internet access line type.

Language
Select the software display language.
The selected language will be used as the Help file language.

NOTE: If you configure the remote control system through the Internet, and change the port number of the
Control, Serial or Audio port, you should reconfigure the port forwarding settings and the IP filter settings on your
router. (p. 4-4)
Transceiver Registration

In the Remote Utility, register the transceivers that are physically connected to your PC. See p. 2-2 to connect a transceiver to your PC.

Adding a transceiver
1. Click "Options."
2. Click "Local/Server Settings."
3. Click <Add>.
   • The “Purpose of use” screen is displayed.
4. Select an option, and then click <Next >.
   ① If you select “Only accessible from this PC,” the registered transceiver cannot be operated from other PCs. If you want to operate the Base station transceiver from other PCs, select “Accessible from other PCs.”
5. Set the transceiver information according to the displayed screen.
   ① See pages 2-7, 3-4, or 4-7 about the settings.

TIP: When you add a transceiver from the Setup Wizard screen, click “Setup for a Server PC (The radio is accessible by Remote PC(s)).” or “Setup for a Local PC (Directly connect the radio and PC).”
① To display the Setup Wizard screen, click “Setup Wizard” on the top menu.
ABOUT THE REMOTE UTILITY

Transceiver Registration

♦ Changing a transceiver’s properties
1. Click “Options.”
2. Click “Local/Server Settings.”
3. Select a transceiver.
4. Click <Properties>.
5. Change the settings, and then click <OK>.

♦ Deleting a transceiver
1. Click “Options.”
2. Click “Local/Server Settings.”
3. Select a transceiver.
4. Click <Delete>.
About the Remote Utility

Transceiver Registration

Adding a user who can access the transceiver

1. Click “Options.”
2. Click “Local/Server Settings.”
3. Click the <User Management> tab.

Adding a user

1. Click <Add>.
2. Enter a user ID of up to 16 characters, case sensitive.
   1. You cannot register an already registered ID.
3. Enter a password, of 8 ~ 16 characters, case sensitive.
   1. At least 2 different characters must be used.
4. Click <OK>.

To prevent unauthorized access:
Set a long and strong password so that no one can possibly guess it. Mix upper and lower case letters, numbers or characters. Periodically changing the password is recommended.
Transceiver Registration

Adding a user who can access the transceiver (Continued)

To allow a user to use a transceiver
1. Select a transceiver that you allow the user to use.
2. Select the user.
3. Click <Add>>.

To inhibit a user to use a transceiver
1. Select a transceiver that you inhibit the user to use.
2. Select the user.
3. Click <<<Delete>>.
To change a user properties
1. Select a user.
2. Click <Properties>.
3. Change the settings, and then click <OK>.

To delete a user
1. Select a user.
2. Click <Delete>.
Server Registration

To connect to a Base station transceiver through the network, Remote PCs should first connect to a Server using the Remote Utility. Before connecting, enter the Server information.

diamond Adding a Server

1. Click <Server List>.
2. Click <Add>.
   • Set the Server information according to the displayed screen.
   ① When connecting to a Base station transceiver through a LAN, see page 3-10 about the settings.
   When connecting to a Base station transceiver through the Internet, see page 4-11.

TIP: When you add a server from the Setup Wizard screen, click “Setup for a Remote PC (A radio with the Server function)” or “Setup for a Remote PC (Connect through a Server PC).”
① To display the Setup Wizard screen, click “Setup Wizard” on the top menu.
ABOUT THE REMOTE UTILITY

Server Registration

◊ Changing a server’s properties
1. Click <Server List>.
2. Select a server.
3. Click <Properties>.
4. Change the settings, and then click <OK>.

◊ Deleting a server
1. Click <Server List>.
2. Select a server.
3. Click <Remove>.
Connecting to a Server

1. Click <Server List>.
2. Select a server.
3. Click <Connect>.
4. “Connected” is displayed under the Server name when the connection has succeeded.
   (p. 7-1)
   ① If the connection fails, and an error screen is displayed, solve the problem.

Disconnecting from a Server

1. Click the <Server List> tab.
2. Select the connected server.
3. Click <Disconnect>.
Connection setting

When the connection to the Server has succeeded, the Base station transceivers are displayed on the Radio List screen. Select a transceiver from the list, then connect it to the network using the Remote Utility. You have to configure the network audio quality and devices to connect.

1. To control the transceiver, connect to the transceiver using the Control software.

**TIP:** If the connection setting is finished, you can simply connect to the transceiver by selecting it on the Radio List screen and then clicking <Connect>.

**NOTE:** When using the DUAL mode screen in the Remote Controller, set the codec setting for "AF Transmission" to 2 channels.

1. Click <Radio List>.
2. Select a transceiver.
3. Click <Settings>.

1. For the transceivers that are "<<Connected>>" or "Offline," the Connection Setting cannot be changed.
Connecting to a transceiver

If the connection setting is finished, you can simply connect to the transceiver by selecting it on the Radio List screen and then clicking <Connect>.

❖ Connecting to a transceiver
1. Click <Radio List>.
2. Select a transceiver.
3. Click <Connect>.
4. Click <OK>.
   • “<<Connected>>” is displayed under the radio name when the connection has succeeded.
   ① If the connection fails, and an error screen is displayed, solve the problem. (p. 7-2)

❖ Disconnecting a transceiver
1. Click <Radio List>.
2. Select a transceiver with “<<Connected>>” under its name.
3. Click <Disconnect>.
   • “Do you want to disconnect the radio?” is displayed.
4. Click <Yes> to disconnect the transceiver.

NOTE:
• Be sure to disconnect when not using the transceiver. Otherwise, other users cannot connect to it.
• The administrators can terminate a connection between another user and a transceiver. If “<<Connected>>” disappears while connecting to a transceiver, the administrator may terminate the connection.
Adjusting audio level using the Remote Utility application

While connected to a Base station transceiver, you can adjust the received and transmit audio volume through the network using the Remote PC’s Remote Utility.

The description in this section is based on the assumption that the connection to the transceiver has succeeded. (“<<Connected>>” is displayed under the radio name.)

**Adjusting received audio volume**
1. Click <Radio List>.
2. Select a transceiver with “<<Connected>>” under its name.
3. Click <AF>.
4. Slide the adjustment bar on the Volume field up or down to adjust the received audio volume level.
   - Click <Mute> to mute the audio, and click once again to hear the audio.
5. Click <Close> to close the screen.

**NOTE:**
- The AF adjustment bar on the Volume field moves together with the AF control of the Remote Controller. However, if you use another control software, the audio volume level on the network can only be adjusted with the Remote Utility.
- You cannot adjust the received audio volume level of the transceiver’s speaker, with the Remote Utility. Use the AF control on the transceiver to adjust it.
- When setting the codec setting for “AF Transmission” to 1 channel, the volume level of both right and left are the same.

**Adjusting transmit audio volume**
1. Click <Radio List>.
2. Select a transceiver with “<<Connected>>” under its name.
3. Click <MOD>.
4. Select “Mic” in “MOD Select.”
5. Slide the adjustment bar on the Volume field up or down to adjust the transmit audio volume level.
6. Click <Close> to close the screen.

**NOTE:** You cannot adjust the modulation input level of the transceiver with the Remote Utility. Adjust the modulation input level of the transceiver in the transceiver’s Set mode, or using the Remote Controller. (p. 6-2)
Recording and playback function

While connected to a transceiver, you can record the received audio and save it into the PC's hard disk using the Remote PC's Remote Utility. Also, you can transmit an audio file to the radio using the Remote Utility. The description in this section is based on the assumption that the connection to the transceiver has succeeded. (*<<Connected>>* is displayed under the radio name.)

**Recording received audio**

1. Click <Radio List>.
2. Select a transceiver with "<<Connected>>" under its name.
3. Click <AF>.
4. Click <○> to start recording. While recording, click <□> to pause.
5. Click <■> to stop recording.

**TIP:**
- When you click <Open Folder>, the folder in which the recording file is saved is displayed.
- If you want to change the recording folder, click <□>, then select a folder on the Browse For Folder screen.
- Adjust the sample rate frequency and codec to record the audio according to the recording purpose. When you record the audio received from the network, we recommend that you set the same sample rate frequency and codec that are programmed on the Connection Setting screen.
### Recording and playback function

#### Playing back and transmitting an audio file

1. Click `<Radio List>`.
2. Select a transceiver with "<<Connected>>" under its name.
3. Click `<MOD>`.
4. Select "File" in "MOD Select."
5. Click `<Open>` to select an audio file* to play or transmit.
   * Only uncompressed, linear, PCM WAV files are supported.
6. Click `<▶>` to start playing/transmitting.
7. While playing or transmitting, click `<▶>` to pause.
8. Click `<■>` to stop playing/transmitting.

---

**TIP:** You can also use the Remote Controller’s Voice Memory function to play back or transmit an audio file. See the Remote Controller’s help file for details. To display the help file, click “Contents” in the Help menu on the Remote Controller, or push the [F1] key on your PC’s keyboard.
Monitoring another users from the Server PC

When you are operating a Server PC, and another user is accessing a Base station transceiver that is physically connected to your PC, you can monitor the received and transmitted audio.
① To monitor, you should connect a speaker to your PC.

1. In the Server PC’s Remote Utility, click the <Radio List> tab.
2. Select a transceiver with “Busy” under its name. ② The operating user’s name (PC Name that the Remote PC set in the Network Setting screen), and its IP address are displayed under “Busy.”
3. Click <Monitor> to display the Monitor screen.
4. Click <TX Monitor> to turn the Transmit Monitor function ON or OFF. Click <RX Monitor> to turn the Receive Monitor function ON or OFF. Slide the adjustment bar on the Volume field up or down to adjust the monitoring audio volume level.
5. Click <Close> to close the screen.
Disconnecting another users

The administrators and the Server PC can terminate a connection between another user and a transceiver.

1. Click <Radio List>.
2. Select a transceiver with “Busy” under its name.
   ① The operating user’s name (PC Name that the user set in the Settings screen), and its IP address are displayed under “Busy.”
3. Click <Disconnect>.
   • “The radio is in use by a remote PC. Do you want to disconnect?” is displayed.
4. Click <Yes> to terminate the connection.
   ① When you terminate a connection, no dialog is displayed on the disconnected user’s Remote Utility.
ABOUT THE REMOTE CONTROLLER

Connect to the Base station transceiver. (p. 2-11, p. 3-14, p. 4-15)

Open the Connect Setting screen. (p. 2-11, p. 3-14, p. 4-15)

About the Remote mode (p. 6-2)

To use transmit audio input from the PC (p. 6-2)

**TIP:** See the RS-BA1 Remote Controller’s Help file for remote operation details, such as how to change the frequency or how to turn ON each function. To display the Help file, click “Contents” in the Help menu on the Remote Controller application, or push the [F1] key on your PC’s keyboard. The windows that are displayed by right-clicking on each button on the Remote Controller, see the Operating Guide at the end of this manual.
6 ABOUT THE REMOTE CONTROLLER

To use transmit audio input from the PC

In order to use the transmit audio input from the PC function when remotely controlling the transceiver using the Remote Controller, configure the following settings, according to the connection between the transceiver and the Server PC.

If you operate from the Remote PC, confirm the transceiver is connected to the Server PC.

1. Connect to a transceiver with the Remote Controller.
2. Click <MIC SET> to open the MIC SET screen.
3. Select an appropriate connector in MOD Select (Remote ON), to input transmit audio from the PC to the transceiver.
   ① The options differ, depending on the transceiver selected in Model on the Connect Setting screen.
4. Right-click <MOD LEVEL> to rotate clockwise, or left-click it to rotate counterclockwise, to adjust the input level from the connector.
5. Click <X> to close the screen.

About the Remote mode

When connected to the transceiver, the Remote Controller automatically turns ON the Remote mode. While the Remote mode is ON, the Remote Controller transmits CI-V commands not only to check the transceiver’s current state, but also to remotely control it.

When you want the Remote Controller to only check the transceiver’s current state, or when you want to inhibit the Remote Controller from transmitting control commands while you manually operate the transceiver, turn OFF the Remote mode.

To turn OFF the Remote mode
Click the Remote icon in the toolbar, or click “Remote OFF” in the File menu.

To turn ON the Remote mode
Click the Remote icon in the toolbar, or click “Remote ON” in the File menu.

① You can select the desired connector(s) for transmitting audio input when the Remote mode is OFF. See the Remote Controller’s Help file for “Remote Setting” details.

NOTE: DO NOT allow the PC to go into the sleep or standby mode while using the RS-BA1. Otherwise, it might not work properly after the PC resumes normal activity.
Using the RC-28

If you connect the optional RC-28 REMOTE ENCODER to your PC, you can use the RS-BA1 and feel like you are operating the actual transceiver’s MAIN dial.

1. Connect the RC-28 to the PC that has RS-BA1 installed.
   ☑ When you connect the RC-28 to the PC for the first time, wait until "Device driver software installed successfully." is displayed.

   **NOTE:** **DO NOT** connect the RC-28 to the PC with other than the supplied USB cable, or through any USB hub. The RC-28 may not work properly.

2. Start up the RS-BA1 Remote Control software.
   • The [LINK] indicator on the RC-28 lights green.
   • Now you can control the assigned functions of the RS-BA1 using the RC-28.

   **TIP:** If the [LINK] indicator does not light, check the following.
   1. Click "USB Dial..." in the Option menu to open the USB Dial Setting screen.
   2. If **Select Device** is set to "Not Use," set it to the RC-28’s serial number.
      (Example: RC-28 02XXXXX)
The following are possible causes and solutions for the problem you are experiencing. If you cannot solve the problem after trying these solutions, please contact your nearest dealer or Icom Service Center.

**Problem: Cannot access a Server from a Remote PC with the Remote Utility**

1. You can configure the Server information on the Server Properties screen. (Server List screen ➔ <Properties>)

---

**“Connection Failed” is displayed under the Server name**

**Possible cause 1**
An incorrect IP address, domain name, or network name (Computer name) is entered to request a connection to the Server.

1. If the Remote Utility cannot get the Server’s IP address using the domain name or network name (Computer name) that you entered, “Cannot resolve the name” is displayed next to the name.

**Solution**
1. Check the Server’s IP address, domain name, or network name (Computer name). (pp. 3-2, 4-2)
2. Enter the Server’s correct IP address, domain name, or network name in **Server Address or Network Name** on the Server Properties screen.

**Possible cause 2**
The control port number is different than that of the Server.

**Solution**
1. Check the Server’s control port number*. (pp. 2-2, 4-4)
2. Enter the correct port number into **Control Port (UDP)** on the Server Properties screen.
   * The default number is “50001.”

**Possible cause 3**
The virtual driver is not installed in the Remote PC.

**Solution**
Install the virtual driver in the Remote PC.
(See the RS-BA1 PREPARATION for details.)

---

**“Logon Failed” is displayed under the Server name**

**Possible cause**
The user ID or password is different than the one in the Base station.

**Solution**
1. Confirm the Remote PC information registered in the Base station. (pp. 3-2, 4-5)
2. Enter the correct user ID and password into **User ID** and **Password** on the Server Properties screen.

---

**“Disabled” is displayed under the Server name**

**Possible cause**
The Server is set to “Disable,” to inhibit connecting to it.

**Solution**
Enable the Server by removing a check mark from **Disable** on the Server Properties screen.
Problem: Cannot access a transceiver with the Remote Utility

The description in this part is based on the assumption that the connection to the Server has succeeded.

• “Connected” is displayed under the Server name when the connection is successful.

When connecting to the network directly:
• Is the transceiver turned ON or Remote standby mode?
• Is Network Control set to “ON”? (pp. 3-2, 4-5)

When connecting to the network through a PC:
• Is the Remote Utility activated?
• Is your Remote station information registered on the Remote Utility’s User List screen? (p. 5-4)
• Is the Remote Utility added as an exception in the Firewall? (p. 1-1)

NOTE: If you could not solve the problem after trying the solutions, check the following on the Base station.

“Busy” is displayed under the radio name

Possible cause
Another user is currently operating the transceiver.

Solution
Wait for “Busy” to disappear.

① If you are operating as an administrator or a Server, you can terminate a connection between another user and a transceiver. (p. 5-16)

“Connect Error” is displayed under the radio name

Possible cause 1
The serial port number (default: 50002) or the audio port number (default: 50003) is not connected.

Solution
Check the Firewall settings for the Remote PC.
When using the Internet, also check the router’s port forwarding settings. (p. 4-4)

Possible cause 2
Access to the selected transceiver is inhibited by the Server PC.

Solution
Allow the Remote PC to access the transceiver with the Server PC’s Remote Utility. (p. 5-4)
“COM/Audio Error” is displayed under the radio name

Possible cause 1
Other applications are using the COM port.

Solution
If other applications are running at the same time, close them.

Possible cause 2
Started the Remote Utility right after the PC has booted.

Solution
Wait for a while after the PC has booted, and then start the Remote Utility.

Possible cause 3
An audio device or COM port has been added to the PC, or removed from the PC.
For the USB device, the USB port number has been changed.

Solution
The COM port number or the audio device name may have been changed.
Reregister the radio on the Registered Radio List screen. (p. 5-2)

Possible cause 4
The audio or serial wiring is disconnected.

Solution
If you are using a USB serial conversion cable or a USB audio cable, make sure the
USB cable is firmly connected.
Make sure the 3.5 (d) mm (1/8”) audio cable is firmly connected.

NOTE: If you could not solve the problem after trying the solutions, check the following.

When connecting to the network directly:
• Is the transceiver turned ON or in the Remote standby mode?

When connecting to the network through a PC:
• Is the transceiver turned ON?
• Are the correct COM port number and audio device to which the transceiver is connected selected on
  the Radio Properties screen?
  (Option ➔ Local/Server Settings ➔ Registered Radio List screen ➔ <Properties>)
• Is the Server PC not directly accessing the transceiver using the Remote Controller, without having
  used the Remote Utility to connect to the transceiver?
Problem: Cannot access a transceiver with the Remote Controller

To access a transceiver with the Remote Controller, configure the connection settings on the Connect Setting screen. Click < > in the toolbar, or click “Connect Setting...” in the Option menu to open the screen. The description in this part is based on the assumption that the connection to the transceiver using the Remote Utility has succeeded.

• “<<Connected>>” is displayed under the radio name when the connection is successful.

When connecting to the transceiver through the network using the Remote Utility

Possible cause 1
In CI-V of the Remote Controller’s Connect Setting screen, the CI-V settings are different than that in the Remote Utility.

Solution
On the Connect Setting screen, click <Search>, and then select the correct transceiver in the Remote Utility menu.
• The CI-V settings are automatically loaded from the Remote Utility.

Possible cause 2
Other applications are using the COM port.

Solution
If other applications are running at the same time, close them.

NOTE: If you could not solve the problem after trying the solutions, check the following.

When connecting to the network directly:
• Is the transceiver turned ON or in the Remote standby mode?

When connecting to the network through a PC:
• Are the same CI-V address and baud rate that are programmed into the transceiver set on the Radio Properties screen?
  (Option ➔ Local/Server Settings ➔ Registered Radio List screen ➔ <Properties>)

When directly accessing the transceiver without using the Remote Utility

Possible cause 1
An incorrect COM port number is set on the Remote Controller’s Connect Setting screen.

Solution
1. Check the COM port to which the transceiver is connected, on your PC’s Device Manager.
2. Set the correct COM port number to COM Port on the Remote Controller’s Connect Setting screen.

Possible cause 2
The CI-V address or baud rate is different than that are set into the transceiver.

Solution
1. Check the transceiver’s CI-V address and baud rate.
   ① See the transceiver’s instruction manual for details.
2. Enter the transceiver’s correct CI-V address in CI-V address (Radio), and select the transceiver’s correct baud rate in Baud rate (bps), on the Remote Controller’s Connect Setting screen.
   ① If the radio’s baud rate is set to “Auto,” select “19200” in the Baud rate (bps) menu.
   ① If you are using the Spectrum Scope function with the IC-7851, IC-7850, IC-7610, or IC-7300 using a USB for the connection, select “115200” in the Baud Rate menu.

Possible cause 3
Other applications are using the COM port.

Solution
If other applications are running at the same time, close them.
TROUBLESHOOTING

Problem: The DUAL mode screen of the Remote Controller cannot be displayed

1. To access a transceiver with the Remote Controller, configure the connection settings on the Connect Setting screen. Click < > in the toolbar, or click “Connect Setting...” in the Option menu to open the screen.

   **Possible cause**
   An incorrect transceiver’s model is set on the Remote Controller’s Connect Setting screen.

   **Solution**
   Select a model named with "(DUAL)."

Problem: Cannot properly control the transceiver with the Remote Controller

   **Possible cause**
   The same CI-V address is being used by other control software.

   **Solution**
   Select an address other than “E0” in **CI-V Address (RS-BA1)** on the Remote Controller’s Connect Setting screen. However, this solution does not always solve the problem.

   **NOTE:**
   If you could not solve the problem after trying the solutions, check the following.
   • Are there any radios that have the same CI-V address in the system?
Problem: The received audio cannot be heard.
The description in this part is based on the assumption that the connection to the transceiver has succeeded.
• “<<Connected>>” is displayed under the radio name when the connection is successful.

Possible cause 1
The speaker is not turned ON, or the volume level is too low.
Solution
Turn ON the speaker, or adjust the volume level.

Possible cause 2
An earphone or other device is connected to the computer in place of the speaker.
Solution
Disconnect the device.

Possible cause 3
The appropriate audio device is not selected in the Remote Utility.
Solution
Select the appropriate audio device in Speaker on the Connection Setting screen.
(Radio List screen ➔ <Settings>) (pp. 3-12, 4-13)
① If you connect a new USB audio device to your PC, the audio device which is selected as a default device in your PC can be changed. If you select “Default Device” in Speaker, keep that in mind.

Possible cause 4
The volume level of the audio device is set to too low on your PC.
Solution
Adjust the volume level of the audio device. (p. 1-5)
① The PC has the Volume Mixer function that can adjust each application’s audio level. Confirm that the Remote Utility or the control software is not muted, or set it to an appropriate volume level.

Possible cause 5
Audio output is disabled in the Remote Utility.
Solution
Insert a check mark in AF Transmission on the Connection Setting screen.
(Radio List screen ➔ <Settings>)

Possible cause 6
The volume level is too low, or the mute is turned ON in the Remote Utility.
Solution
Adjust the volume level on the Received Audio Adjustment screen.
(Radio List screen ➔ <AF>) (p. 5-12)

NOTE:
If you could not solve the problem after trying the solutions, check the following.

When connecting to the network directly:
① Is Network AF set to an appropriate level in the Others set mode?

When connecting to the network through a PC:
① Is the volume level of the audio device that the transceiver is connected to set to an appropriate level?
Problem: The received audio cannot be heard in the DUAL mode.
See also “Problem: The received audio cannot be heard.”

Possible cause 1
The codec setting for the received audio is set to 1 channel on the Remote Utility’s Settings screen.

Solution
Set the codec setting for the received audio to 2 channels.

Possible cause 2
When the transceiver is connected to the PC with a USB cable, the audio device setting is incorrect.

Solution
Set the microphone’s Default Format to 2 channels on the Windows Sound setting screen.
Problem: The transmit audio cannot be output.
The description in this part is based on the assumption that the connection to the transceiver has succeeded.
• “<<Connected>>” is displayed under the radio name when the connection is successful.
① To check the Remote PC’s transmit IF signals, use the Transmit Monitor function with the Server PC’s Remote Utility, or place a receiver near the Remote PC or Server PC.

Possible cause 1
The microphone is not turned ON, or the input level is too low.
Solution
Turn ON the microphone, or adjust the input level.

Possible cause 2
The appropriate audio device is not selected in the Remote Utility.
Solution
Select the appropriate audio device in Mic on the Connection Setting screen.
(Radio List screen ➔ <Settings>) (p. 5-10)
① If you connect a new USB audio device to your PC, the audio device which is selected as a default device in your PC can be changed. If you select “Default Device” in Mic, keep that in mind.

Possible cause 3
The input level of the audio device is set to too low on your PC.
Solution
Adjust the input level of the audio device. (p. 1-5)

Possible cause 4
Audio input is disabled in the Remote Utility.
Solution
Insert a check mark in MOD Transmission on the Connection Setting screen.
(Radio List screen ➔ <Settings>)

Possible cause 5
The input level is too low in the Remote Utility.
Solution
Adjust the input level on the Transmit Audio Adjustment screen.
(Radio List screen ➔ <MOD>) (p. 5-12)

Possible cause 6
An incorrect connector is selected in the Remote Controller.
Solution
Select the proper transceiver’s connector which is connected to the Server PC, in MOD Select (Remote ON) on the Remote Controller’s MIC SET screen. (p. 6-2)

NOTE:
If you could not solve the problem after trying the solutions, check the following.

When connecting to the network directly:
• Is Network AF set to an appropriate level in the Others set mode?

When connecting to the network through a PC:
• Is the volume level of the audio device that the transceiver is connected to set to an appropriate level?
7 TROUBLESHOOTING

Problem: The received audio is intermittent

Possible cause 1
The network data transfer is excessive.

Solution
Select a lower sampling rate value in **Sample Rates**, or a different codec in **Codecs**, on the Connect Settings screen. (Radio List screen ➔ <Settings>)

① First, select the lowest value. If the received audio is not interrupted with the setting, try a higher value, and adjust to an appropriate value.

Possible cause 2
The capacity of the prebuffer is not enough.

Solution
Select a longer value in **Prebuffer (ms)** on the Connection Setting screen. (Radio List screen ➔ <Settings>)

① Select as short a value as possible, because longer prebuffers can cause a delay, and make it difficult to adjust the audio level.

Possible cause 3
Your PC is overloaded.

Solution 1
Shutdown other applications, if running.

Solution 2
Reduce the number of transceivers you are accessing with the Remote Utility.

NOTE:
• If you are accessing the transceiver through a network, removing a check mark from **Retransmission** on the Connection Setting screen can solve the problem. (Radio List screen ➔ <Settings>)
• You can check the simplified packet round trip time, and the average packet loss on the Remote Utility’s Server List screen.

Problem: The connect settings cannot be changed

Possible cause 1
The transceiver is “Offline.”

Solution
Click <Connect> on the Server List screen to connect to the server.

Possible cause 2
“<<Connected>>” is displayed.

Solution
Click <Disconnect> on the Radio List screen to disconnect from the transceiver.
Problem: The connect settings cannot be changed using the Remote Controller

Possible cause
The Remote Controller is connected to the transceiver.

Solution
Click < > to disconnect it from the transceiver.
Count on us!
Remote Controller Operating Guide (DUAL mode screen)

The following windows are displayed by right-clicking on each button on the Remote Controller.

1. There are some windows that are displayed by left-clicking. The buttons are marked in white.
   (Example: Memory Channel Editor).
2. The windows whose title are with "(MAIN)" are displayed when you select the MAIN band.
   When you select the SUB band, "(SUB)" is displayed instead.
3. The windows that are displayed by right-clicking can also be displayed by right-clicking on the screen icons.

TIP:
• You can select either "Knob" or "Slider" on the Set Mode screen to adjust each setting.
  (Set Mode > Controllers > Control Type)
• Some windows are not displayed, depending on the connected transceiver.

➊ The example when connecting the IC-7850 or IC-7851. The window differs, depending on the transceiver’s Scope function.
➋ The example when connecting the IC-7850 or IC-7851. The window differs, depending on the transceiver.
❼ Displayed when using the Tone function. The window differs, depending on the Tone function you use.
➍ Click to display the Scope screen of the SUB band.
➎ Displayed when using the RIT function or ΔTX function.
Remote Controller Operating Guide (Single mode screen)

The following windows are displayed by right-clicking on each button on the Remote Controller.

1. There are some windows that are displayed by left-clicking. The buttons are marked in white.
2. The windows that are displayed by right-clicking can also be displayed by right-clicking on the screen icons.

- Example: Memory Channel Editor
- Example when connecting the IC-7850 or IC-7851. The window differs, depending on the transceiver's Scope function.
- Displayed when using the Tone function. The window differs, depending on the Tone function you use.
- Displayed during the Duplex operation.
- Displayed when using the RIT function or ΔTX function.

TIP:
- You can select either “Knob” or “Slider” on the Set Mode screen to adjust each settings (Set Mode > Controllers > Control Type)
- Some windows are not displayed, depending on the connected transceiver.